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TCO Displays 5.0 Information

Congratulations,
Your display is designed for both you and the
planet!

This display carries the TCO Certified label. This ensures that the display
is designed for minimal impact on the climate and natural environment,
while offering all the performance expected from top of the line electronic
products. TCO Certified is a third party verified program, where every
product model is tested by an accredited independent test laboratory.
TCO Certified represents one of the toughest certifications for displays
worldwide.

Some of the Usability features of the TCO Displays 5.0 requirements:
Visual Ergonomics

Good visual ergonomics in order to improve the working environment for the user and to reduce sight and
strain problems. Important parameters are:

e Light levels without color tint, Uniform color and luminance, Wide color gamut
e Calibrated color temperature and gamma curve

e Wide luminance level, Dark black levels, Low motion blur

Electrical Safety

e Product fulfills rigorous safety standards



Emissions

e Low alternating electric and magnetic fields emissions
e Low acoustic noise emissions

Some of the Environmental features of the TCO Displays 5.0 requirements:

e The brand owner demonstrates corporate social responsibility and has a certified environmental
management system (EMAS or ISO 14001)

Very low energy consumption both in on- and standby mode

Restrictions on chlorinated and brominated flame retardants, plasticizer and polymers
Restrictions on heavy metals such as cadmium, mercury and lead (RoHS compliance)
Both product and product packaging is prepared for recycling

The brand owner offers take-back options

The requirements included in this label have been developed by TCO Development in co-operation with
scientists, experts, users as well as manufacturers all over the world. Since the end of the 1980s TCO has
been involved in influencing the development of IT equipment in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now requested by users and IT-manufacturers all over the world.

For more information, please visit www.tcodevelopment.com

Technology for you and the planet

RETURN TO TOP OF THE PAGE

Recycling Information for Customers

There is currently a system of recycling up and running in the European countries, such as The
Netherlands, Belgium, Norway, Sweden and Denmark.



In Asia Pacific, Taiwan, the products can be taken back by Environment Protection
Administration (EPA) to follow the IT product recycling management process, detail can be found
in web site www.epa.gov.tw

The monitor contains parts that could cause damage to the nature environment. Therefore, it is
vital that the monitor is recycled at the end of its life cycle.

For help and service, please contact Consumers Information Center or F1rst Choice Contact
Information Center in each country.

RETURN TO TOP OF THE PAGE

Waste Electrical and Electronic Equipment-WEEE

Attention users in European Union private households

This marking on the product or on its packaging illustrates that, under European
Directive 2002/96/EC governing used electrical and electronic appliances, this product may not
be disposed of with normal household waste. You are responsible for disposal of this equipment
through a designated waste electrical and electronic equipment collection. To determine the
locations for dropping off such waste electrical and electronic, contact your local government
office, the waste disposal organization that serves your household or the store at which you
purchased the product.

Attention users in United States:

Like all LCD products, this set contains a lamp with Mercury. Please dispose of according to all
Local, State and Federal laws. For the disposal or recyciing information, contact
www.mygreenelectronics.com or www.eiae.org.

RETURN TO TOP OF THE PAGE



EPEAT

“The EPEAT (Electronic Product Environmental Assessment Tool) program evaluates computer
desktops, laptops, and monitors based on 51 environmental criteria developed through an
extensive stakeholder consensus process supported by US EPA.

EPEAT system helps purchasers in the public and private sectors evaluate, compare and select
desktop computers, notebooks and monitors based on their environmental attributes. EPEAT
also provides a clear and consistent set of performance criteria for the design of products, and
provides an opportunity for manufacturers to secure market recognition for efforts to reduce the
environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste

RETURN TO TOP OF THE PAGE

ROHS is a European Directive aiming to control the use of certain hazardous substances in the
production of new electrical and electronic equipment. Philips has completely eliminated four of
six RoHS-banned substances form its products by 1998-eight full years before compliance was
required and has lowered usage of the remaining substances significantly below the mandated
levels.

RETURN TO TOP OF THE PAGE



CE Declaration of Conformity

This product is in conformity with the following standards

- EN60950-1:2001 (Safety requirement of Information Technology Equipment)

- EN55022:2006 (Radio Disturbance requirement of Information Technology Equipment)
- EN55024:1998 (Immunity requirement of Information Technology Equipment)

- EN61000-3-2:2006 (Limits for Harmonic Current Emission)

- EN61000-3-3:1995 (Limitation of Voltage Fluctuation and Flicker)

following provisions of directives applicable

- 2006/95/EC (Low Voltage Directive)

- 2004/108/EC (EMC Directive)

and is produced by a manufacturing organization on 1ISO9000 level.

The product also comply with the following standards

- 1S013406-2 (Ergonomic requirement for Flat Panel Display)

- GS EK1-2000 (GS specification)

- prEN50279:1998 (Low Frequency Electric and Magnetic fields for Visual Display)

- MPR-1l (MPR:1990:8/1990:10 Low Frequency Electric and Magnetic fields)

- TCO'03, TCO Displays 5.0 (Requirement for Environment Labelling of Ergonomics, Energy,
Ecology and Emission, TCO: Swedish Confederation of Professional Employees) for TCO
versions

RETURN TO TOP OF THE PAGE

Federal Communications Commission (FCC) Notice (U.S. Only)

digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency

g This equipment has been tested and found to comply with the limits for a Class B



energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Use only RF shielded cable that was supplied with the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT REGULATIONS.

RETURN TO TOP OF THE PAGE

FCC Declaration of Conformity

Declaration of Conformity for Products Marked with FCC Logo,
United States Only



C

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

RETURN TO TOP OF THE PAGE

Commission Federale de la Communication (FCC Declaration)

Cet équipement a été testé et déclaré conforme auxlimites des appareils
numeériques de class B,aux termes de l'article 15 Des régles de la FCC. Ces
limites sont congues de fagon a fourir une protection raisonnable contre les

A interférences nuisibles dans le cadre d'une installation résidentielle. CET appareil
produit, utilise et peut émettre des hyperfréquences qui, si l'appareil n'est pas
installé et utilisé selon les consignes données, peuvent causer des interférences
nuisibles aux communications radio. Cependant, rien ne peut garantir 'absence
d'interférences dans le cadre d'une installation particuliére. Si cet appareil est la
cause d'interférences nuisibles pour la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de corriger la situation en prenant les
mesures suivantes:

Réorienter ou déplacer I'antenne de réception.

Augmenter la distance entre I'équipement et le récepteur.

Brancher I'équipement sur un autre circuit que celui utilisé par le récepteur.
Demander l'aide du marchand ou d'un technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu I'approbation des services compétents en
matiére de conformité est susceptible d'interdire a I'utilisateur l'usage du présent



@ équipement.

N'utiliser que des cables RF armés pour les connections avec des ordinateurs ou périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR DU CANADA.

RETURN TO TOP OF THE PAGE

EN 55022 Compliance (Czech Republic Only)

This davica belongs to catagory B devices ae described in EM 55022, unless it is spacifi-
cally stated that it is 8 Class A davics on the specification labal. The following applias to
devices in Class A of EN 55022 (redius of profection up 1o 30 meters). The ussr of tha
devica is obliged to taks all stapa necessary to remove sources of intarference 1o tala-

communication or cther devices.

Poleud neni na typowem &tithu poSitade uvedeno, e spadéd do do ffidy A podle EN 55022,
spadd automaticky do thidy B podie EN 55022, Pro zafizeni zafarend do tfidy A (chranné
pésmo 30m) podle EM 55022 plat ndsledujicl. Dojde-li k rufani telekomunikatnich nebo
Pnyich zafizeni je ufvatel povinnen provést takovd opatfgnl, aby rubend odstranil.

RETURN TO TOP OF THE PAGE

Polish Center for Testing and Certification Notice

The equipment should draw power from a socket with an attached protection circuit (a three-
prong socket). All equipment that works together (computer, monitor, printer, and so on) should

have the same power supply source.

The phasing conductor of the room's electrical installation should have a reserve short-circuit



protection device in the form of a fuse with a nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the power supply cable must be removed from the power
supply socket, which should be located near the equipment and easily accessible.

A protection mark "B" confirms that the equipment is in compliance with the protection usage
requirements of standards PN-93/T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Urmgedzemie powinno byé sasibane 2 priazds @ preybgcsanym obwodem ochrennyem (gniaedo
kolkiem). Wapﬁm‘rjatujatn 2z aohy uregdrenta (kosmpuser, monaor, drukarka) powiniy byd zasilame
# bpn sambepo drddla

Instalacja elektrycma pomicsocoenia powinna mwiend w preewaodsie Brewym nezeraowa achrang
prazd rwarciami, w postaci beeprecinika o wartodéci mamionowe) e wigksze] nie 16A (amperiw ).
Wooelu cathowhiego wylacrmia ureadeenia ¢ siect zasilania, nalezy wyjad wivezke kabla
easilajgeego » priaedka, kidre powinno srxjdowad ssg w pobliag Lumd'l ciida o bl Batwo deatgpine.

Enak berpleceeiatwa "B potwicrdes ppodnost wrepdzema & wyniigaibainl bezpleceeistwa
whvtkowaita rawartvind w PR-AT-42107 1 PR-EEAG2S]L

Pozostale instrukcje bezpieczensiwa

* Mie maledy wivwad wiverek sdapterowych lub isuwad kelka obwodu schrommego & wiyeeki.

Jekeli konsecene jest wiycw peaadluzaces w naleky whyé preedhizace 3-rvlowego 2

prawidlowo pobgczonym praewodem ochronnyn.

System kompulerowy naleey xaberpiccrwd preed napbyme, chwilowymi warostami lub spad-

kami napapcil., whvwijac eliminalors preepeed, uresdrenia dopasawuajgcegn lub

bemakbocemowega irodia zaslan

Malezy upewnit sig. aby nxe nie leklo na kablech systemu kompulerowego, araz aby kable me

byly umleszceone w mlegscu, gdese modna byloby na nle nadephywad lub poryksd sig o me.

Mie maledy roelewad napopve and mych plynde na system komputerowy.

Mie malery wpychat mdnych preedmictow do atwordw systenmu kempuiervwe pa, gdye moie

ta spowodowac podar lub porasenie prydem, popreez ewarcie elementdn wewngtrenyche

* Syatem komputerowy powimen snapdowad sig 2 dala od greejnikdo 1 inddel clepla. Porsdio,
mie maleiy blakawad atworaw wentylacyjnych. Nabeiy uanikas kladeensa hinveh papserda posd
kampaler onu umieseczanza kampulera w casnym migjscu bes mazhwaso cyrkualacy pown-
eirra wokol niego.
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North Europe (Nordic Countries) Information

Placering/Ventilation



VARNING:

FQRSAKRA DIG OM ATT HUVUDBRYTARE OCH UTTAG AR
LATATKOMLIGA, NAR DU STALLER DIN UTRUSTNING PAPLATS.
Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT NETLEDNINGENS STIK OG
STIKKONTAKT ER NEMT TILGANGELIGE.

Paikka/llmankierto
VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO VOIDAAN TARVITTAESSA
HELPOSTI IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon
ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA DU PASSE PA AT
KONTAKTENE FOR ST@MTILFZRSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den in der "Verordnung tiber den Schutz vor
Schaden durch Rontgenstrahlen” festgelegten Vorschriften.

Auf der Ruckwand des Gerates befindet sich ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften Uber die Bauart von Stdrstrahlern nach Anlage Il o
5 Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung geforderten Werten entspricht, ist darauf zu
achten, daf}

1. Reparaturen nur durch Fachpersonal durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.
3. bei Ersatz der Bildréhre nur eine bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen, die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte Lesbarkeit und erhéhte Augenbelastung bei
zu geringem Zeichenkontrast waren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach DIN 45 635 betragt 70dB (A) oder weniger.

ACHTUNG: BEIM AUFSTELLEN DIESES GERATES DARAUF ACHTEN, DAR
NETZSTECKER UND NETZKABELANSCHLUR LEICHT ZUGANGLICH SIND.

RETURN TO TOP OF THE PAGE



End-of-Life Disposal

Your new monitor contains materials that can be recycled and reused. Specialized companies
can recycle your product to increase the amount of reusable materials and to minimize the
amount to be disposed of.

Please find out about the local regulations on how to dispose of your old monitor from your sales
representative.

(For customers in Canada and U.S.A.)

This product may contain lead and/or mercury. Dispose of in accordance to local-state and
federal regulations.

For additional information on recycling contact www.eia.org (Consumer Education Initiative)

RETURN TO TOP OF THE PAGE

China RoHS

The People's Republic of China released a regulation called "Management Methods for
Controlling Pollution by Electronic Information Products" or commonly referred to as China
RoHS. All products including CRT and LCD monitor which are produced and sold for China
market have to meet China RoHS request.
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Lead-free Product

Philips eliminated toxic substances like lead from its displays. Lead-free display
helps protect your health and promotes environmentally sound recovery and
disposal of waste from electrical and electronic equipment. PHILIPS Brand designs
and produces display products in compliance with strict Restriction of Hazardous
Substances (RoHS) european legislation that restrict lead and other toxic.

RETURN TO TOP OF THE PAGE
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SmartConkrol 1T
Installer, exe

SmartControl |l
Welcome to the InstallShielf Wizard For SmartControl

The ‘Wizard wall inst 2l SmartCantrol on your compuker. To condinoe, dick Mext.
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AdLET oo

Wizard

BlLging

FrRials DpTrg

roourlinaad bo callbrate wour dEply bo 0ot the most arourate ook, W BNOoURS08 Yo o use the amplke wning
pracess by seleding the Sceet Wizard bubton, This prooess ireolved & series of sbeps that mill ks you bune your

displry and s the sobtings.

L. Chexse e Slart Wizard button.
2. Follovs tha staps outinad inthis process.
3. Sk vl $ElBAGE har e LER
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o adet ]| coer J__ e | e | opons ]| nEe |

(] Brightness Brightness 0
OO )

npropery adjushed Brighbness will resUt i a lossof detal i darker nage areas. Adist the Brichinass

for the best possbe pichure quadity.

1. Lk e Battern Button 0 bilndg LD the sdjusment nage.

2. Lowwer the Brinhiress ueitil e datk strioes Berd together,

3. Slawhy raisa the Brightness untl sach of tha dark slripes become viable.
Ty b Bchigse Bh squal sepsrstion. The dirkad dhesId Shasyd resain Hade

SmartControl Il PHILIPS
T ca | Pogns || Pesets | Optons | | el J

Contrast Conrast o
Aty the Contrase use the shoer) bo keep detsls 11 bohber mage aras. L (S —

1. Lisa the Pttee Butten 0o Brng up Uhe Sdytment mags,
2. R the Cortrast untl the rarsbers | and 2 anenn nnger vidbis,
3. Sowdly lowser Uhay CORCTAEE £0 Ml et nirmbesrs 2 and 3 neappaear Thes rusnisd | gl remasin barsly vidbls.

E [N [
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| aduat | | Calr | Phagins ] PrEdEts | optors | Heln |

(3] Focus FRch L]
Your diepbyy's timing resnds b bey gynchroniznd with the videa signal, DL:HEI
e e —— [
;.I:m:l.l-:nﬂlp. . EI

3. If the vertical bands are sl visible, youll nesd to adiust the Prch.

Pitehe Try bo reale the verticd bords doappear Phase: Adjust tothe beightest setling be minimise
mervemmend on the streen.

I ETTIT I . -
. T — ey Ty e —— ey

[ Lo | [ mtoSenn |
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SmartControl I PHILIPS
Pasition
g the Poskion bubtons ba cenber e g on your displing. Liirg this ko, you can pekion e image up, diwn, (2
1. L Ritw Pttt Btbon B Bring up tha adiustnenit mnmaos i)
2. Lipi e LD Bt Bo 2anibir i iribgs veatically,
. Lt thvs Ladfe Flight Buthester bo cinee th g Prariportaly. y P—

e

- - .
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SmartContral |l PHILIPS
Adpst | Colce L Flugns L Cpbions L Help | Presets

E] Rasolution

Yeui e ournently ot & Prefemred resolution, For your deplsy to show [T Emable Reschtion hickifier

erig, thear beck, colors, and meded, your dapiay ook B set ko k3 = Erable :3 .

Prelerred resobution.

¥ yoir dsplay i a8 & Nosn-Prelerred reschation, dick on the Prefereed
butiton b change your resolution to Predermed.
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(o)) Color Aailal)

5 Ol B oaa s sliaul) Al 5 35 (5 sinsall s RGB 43 Lasas (01 5191) Color aidl) ll manss @
.(Smartimage =1l M g 5=l ¢laJll) Smartimage
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acpse | | coe . |  euors || mems || opom

(1] RGE

&l dsplayed colors are produced by mbdng Red, Blus and Green at dflenent brighcness levels. Choosing 2 neral
yiite: Point sl give you opbineal FiGB. IF you prefer 1 mdjast Bhe RE nowy, Folow these steps:

1. Lz the Pattern Buon i bing LD the adjusmient iage.
&, gt the: inkoroky of the Fed, Groon snd Blue using the slhider bers,

Nl Charging the RGE vslugs £ah Sdvensely sifecs thi deplayed colors.

[ undo | Rossk |
v
SmartContral |l PHILIPS
Adpst ] Cole ] Pugrs | pressts | optons | | Hai ]
White Point White Pank
White Point is the poink at which equal combinstions of red, green and blus ight st full interuity croate white, TThis Dtc-a
affests the cenll ook qualty, For e mosk acourste cokoes click the Resek butfon then select the Whibe Peink. | Liser |
1. Line the Paktern bubton ko bring up the adiustment mage.
2. Helding & pece of white paper next ko the dapley, chooss the Whibs Poirt walue that mabes the displey mabdh
the white paper,
) T . : ®
p— = —y p— = —— — = ——y
[ Urde ] 1 Firset |
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SmartControl |l PHILIPS
L aast | coor  J| mors [ optos [ Heo [ Presets

7] Gamma Barmma 2.2
Gaing i & compront of Eha pixel brightress in a daplay. A kv Gamma valus produces brighter pisols and o DE:_

Figher Garean vobas produces darker peoels. Nermal comgater diplars use & Garmina vahse of 2.2,
To adpust Gormma, Searlmege has bo be off, Chck the “Smartlnege O butten before adiusting Gamms.

1, U tha Potbern button to bring u the adiustment mage.
2. Use the shder b seleck the desired Gamna,

Smart Control | PHILIPS

et ) e PO ) P ] ouwers ] vew )
[=%] Color Calibration
Wour displary nesds t be properdy calbrabed in onder For & bo producs the wadest: rangs of colors scourstely.

Callbration shoukd sharys baks place s the Lt buning stepin the pretess, Femanber to recalbests any tine you
raake inchvicisal adiustnants b imge quaity or whanever you movs your dpley bo & ew kecation.

1, Maka ol cthir racatsany sdjestmants 10 Feage qualty First.
& Prose Thow Me'to learm Bow bo uee the calibr gtaon ook
3. Finsly, procr Staet Lo begin the caltr akion procest.

[ Enalie Color Callbration

Color goftweane desigreed in colaboration with Joseph Holmess .
Prctactad by L.5. Paters Mo, 6,596,953

[ _mee ][ cuchwem ]

O 8 el el iyl Jii s e (A JlelsY) "Show Me" dexi .1
Ll shd 6 (e ¢sSall () Y 5 plae Judis ey - (Jsiil) o) Start .2
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(<a1al B) 3Dl Cargdl I Jumy) Y (Jall) Next L0 gas
(GBeud) dlae i<l File>Presets ) Jauy! JI (S A4 Final next o3V o
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SrartControl 11 PHILIPS
Y Y I — J . P ] Pratets | Ootiors | | Mo ]

Smartlmage

Smartimage provides dfferent brightnass and contrast level to accomodate today's wade range of computar

IpplcTons.

Choose the setting that is mast comfortable or efficent when viewing your application. ARermnatiely, simoly
choose the one that best describes its type.

[Lxrage viewng |
Entartanmant

il gl Uacuiall Aailill ¢a (Jsma) 513) Asset Management waas dic Jhid Ladi (Jsa¥) 514) Asset Management 4a st ¢ sSiu - Ldlay) <l oY)
gLy

W

SmartControl Il PHILIPS
[ Adwst ] Coler | o pmgms | Options ] [ Help ] Prasets ]

Agzet Management

Mamutacturer Carrent Timing

Philps Bectronics 10247 6E0 Ha

D= scripbsom Drrmvain Mame

PHMEL 2458 POATRALT

Seral Mumber Computer Hame

S 7HUF GHAS Slabemon
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Alay) Ciilds sl Aswial) Ladlill (i (48 edl) Theft waad sie L Ahads (43 ) 4a5is) Theft Deterence 4ss! ¢ oSin - LLaY) <) 5aY)

8 SmartControl I El
SmartControl Il PHILIPS
Adpst | Color | Phug s | Options | Helg: J Prasets |

[E' Theft Deterrence

Thaft Detemencs profects vour display against Lnauthorized removal from your cormputen. To Enabla Theft
Datermance, cick on Enabla Thaft. Arst-tme wsens will requing 3 Pargonal Jdentification Murmber (PIN). If tha

displa i remeved froem this eompater, this PIN i resdad to suthoribs Use o srothel cormputer. Thaft Daterarce Drabled

Enable Thaft

sl LELA gl ) (4 md) ¢psad) Enable Theft U30 (asd Al a5 (48l 4aglie) Theft Deterrence ¢nsail
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SmartControl |l PHILIPS
Adpst | Color | Flug-ins | Options | Help | Prasats |

(2] Theft Deterrence e batoos chpley e ceschec |

Thaft Deteirercd & cunantly Disabled. To anable Thaft Daterrencs, antar your PN in tha bow Bolow, than L‘I _] |_]

cick ACoRpE. - &

Eritier FIN 0 enale Thieft Determenca:

Reenter PIN o ﬂ!r:

i i) G al 9 1 4 (e 05Se PIN 85 Jia) pasiad) wolais 1

Adull dagall e o ga sal) @il ) sall g pe ) pasieall Ji ) (Js8) Accept L3V gos PIN @) Jas) a2
el Bl U8 5 ) (31 i) Jay ) (e oy (3583 5 ) G oY) aal (pad iy 3

4

alide Canimay (i pall L3LE B ) 48 ) g ) JEiY) allaty Y

tll) ) gal) ae sgdiy Ban) g 8 pe Adsidy PIN ady Jia) ady of 3 e

M SmartControl Il fsa
Hzt
SmartControl |l ?

Register your PIM online (requires connection to the ntermet )

PHILIPS __ves | No )
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& SmariCantrel Il
SmartControl I PHILIPS
At J Colar ] Fhugine | oo | Hialp J Fresats ]

E] Theft Deterrence

Thiaft Datismancs protects your digplay ageirdt unauthonmed remova fom your comouter. To Dable Thift
Cetemence, didk on Diable Theft. Frst-time wusers will reguine a Persond Identification Humber (FIN). If the
displary s removed from this computer, this PIM i needed to suthonze wse on anothes oofnpuber, Thaft Deterance Enabled

el Thaghadl gl @ n dniem ) QN () Yes 530 G54 o

:(PIN < Jki) PIN Options JJl s "A8 sl daglia” (psad ) (48 puall 4aglis) Theft Deterrence da sl sudia (PIN slid) 2



& SmariCantrol Il

SmartControl I PHILIPS
Adst p Colar | Fhugins | owtors | Hialp Fresats |
E] Theft Daterrence
Thuaft Daterande (rOTects yOLF depiay sQendt undutholized rermova fom your comouter. To Diabks Theft
Cetermence, did: on Disable Theft. Frst-time users will regure a Parsonal Identification Humber (PIN). If the
display is removed from this computer, this PIM i needed to suthonize use on another oomputer, Thaft Detemence Enabled
Dbz Theft

8 el e 4S5 o e ]
A Al e 83y sal) AILA Al i ) " Qe g3 2

PIN a8 alasiuly e cus @ise i 5l 138 (35 (PIN &) Ll ardiud) o8 2, Lt (PIN & L3) PIN Options U3 Jish .3

A Aa gl b L) (A8l Juat) Disable Theft L3V g2
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PHILIPS

SmartControl |l

At J Ciokor

J Plug-ins Optians 3 i J Precals

@ Theft Deterrence

Thoft Ditemance & cumanty Enabled. To disable Theft Deterenca, entar your FIN In the box below, than
chck Accept.

Ervier PN to disable Thefi Deterrence:

[ mcceot |[  cowel |

PIN & dulaas ) (U 58) Accept L 23 PIN ) Jia) aa

&a3) Enable Theft 31 48 pull daglia Juast & (o j28 & 5 Ao Jl) (38l 44 4l50) Theft Deterrence 4a o i J) (1) Cancel L3V g2 .2

.(PIN <i_a) PIN Options s (38l
(S sl a e el () e e PIN 6, Jis o 3

R SmartConirol 1l

hett Laterrence error

SmartControl | |
Falied to disable theft deterrence!

Please reenter the PIN and try agan.

PHILIPS

[ ox |

LA dpudlly (< lad) Options Aiwial) 4l ¢ (cDluailll) Preferences wiad vie Jiid i) a4 - (cdbuaiili<e) LAY) Options>Preferences
i (<l lall) Options s (wlaiadll) Help cusdl) Aade 58455 ol <DDC/CI ao 53 Y (Al )
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SmartContral |l PHILIPS
Adjust Colice Plugines | Cptions | Help | Presets

E] Preferences __ LED Erghtnacs -

ioug can use e (olowing options bo configure SmamContiod 1T [rmprcrved el ertainment; —] _ [—]

& Ensbls manu when right-dicking on deckbop I~ Ensbls SmatRecponcs

W Enable task bray menu ™ Enabde SmartCortrast

ko R sk svstem chart-up

Sal Trancparency
& 0% O S & 100

Saisct Language

Eregish x

Al Alaiall cldlae Yl e L]

(el AL LAY AR 5 el 0da (0S8 (M g sall st a2
b Aalall Slaaail) (3led) 8a5) Enable Context adldll (a jai | ocal il Jli (Jueiill) (Blnd) :845) Enable Context il yaas o3
b e 83 g gall (Gland) AailE (358 ) e slall 30 il die (sl lawz) Tune Display s (G slae) 32a5) Select Preset 2 SmartControl |
) Gaslall ) Ll Rl die L) Al SmartControl 11 40) ) dabasill (525, iSal)

2 ualal) Al e gol Aals " Elndl (S A s |l i) S (L) ) (pleadl < ol ,85) Enable Task Tray il yasi o .4
s (A8) Upgrade 2as " il acall” 5 "clalailly” dalal) Al Gl LA (i je ) aleall S gal ey G ) Lustall e s @23 .SmartControl ||
i olgiy) die algal) il 5ol 3e ) Jlela) wii ¢"algad) il sl oS AE) Jolaat &% Lenie | (sLe3)) Exit 5 (Jsa) About

@ 258 oy daslill ey ie SmartControl 1 dsis e s (F edibanl) i aal 381 JS5 (sl e 2ie Jaall) Run at Startup - (Jsels) sasialy L5
sl daend iy () gmalpall ke (e sl IS e e 3 g gall Jlaia¥) aladiuls L) 4 SmartControl 11 dsus e sas ol 48kl ) sSin g slgall il 50
(Ibas) @) 138 aaataae Ala 8 i geSl Ji o3y die Jnilly Blaty Gaasa Slac)

s e %0 s ol BV dlaeY) (ki 2k 5 XP S Vista) il pas 0Sa .6

oY (A ) LB Al (@I UaY) Options Aswial) Aailil) e (Ja) Input a3 i Jabd a2l o3y - (JBs<el il Options>Input
s AY SmartControl Il uss clade Bl Jhgi ¥ ki (<) Lal) Options s (<ledill) Help cusidll iadle L g a% <DDC/CI
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SmartControl Il PHILIPS
At | e | pugs | Presets | Options | W ]
Inpust

Your displry has two iputs (connections on back of ths deoley) 50 you can hook up two different sources at
the mme tima. Use the Analog [n and Digital In buttens to select whidh source you'd Tke to view. Wou are

curmenthy wewing tha Digital In maga.

TMPORTANTI F you switch mputs SmartControl Il may bee the abiity to conbrol your montor, In ths casa you
oy have to use the Input Salect bution on the front of your monktor to awvich badk to the criginal nput
befoie SmatCantrol I functionalty can be restored,

[ amabgw [ ogeaw [ ogmalm |

Al Jiay) jaas dlae) 5 " jaad il Y dadl g e ]

e da gl ol S5 o egah JA @l g e cllils e 2

J(<Ikad) Options Uswial) Laildll (a (< guall s sias) VOlume yaad vl Jakh Jaiidl) o3 - (< guall<) LAY) Options>Audio
A (<) LAY) Options . (<lasixill) Help cusill feds b6 ol <DDC/CH as 5 Y (Al (2 pad) AL dpaily
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adust | coee ] Pugns Pasots || opuons ] b |
(4] Audio vokume 0
Sdint the volume of the integrated loudspeakers by wsing the didec D_
Turrs ofF e inbegrabad boudspssbers by chacking the Muks chsckbon.
e

Option>Auto Pivot

SmartControl || PHILIPS
(L Adust [ cox [ muons L Hee [ Cotors | Preses
)] Auto Pivot
To manhualy rote tha scraen rage, ok 3 romtan button. Undhadk the Auto PRIC box 00 dEabiG JUTOMATC
EITERN-T@ae rotation.
[ Enibla Auta ProL.

o° 90° 180° 270° e 1]

L(Glaslail)) Help dailill Aacial) Al (e (a2dieall J213) User Manual waas die by &) sl - (adiieal) Jilaccileail)) Help>User Manual
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Main menu

— Input

I— Picture

— Audio

= Caolar

= Language

= 05D Settings

— Setup

Sub menu

|: VGEA
DI (available for selective models)

— Picture Format — 4:3, Wide screen

— Brightness
— Contrast
— SmartContrast — On, Off
— Gamma — 1.8, 2.0, 2.2, 2.4, 2.6
— Stand-alone — On, Off
— Mute — On, Off
— Color Temp.  — S000K,6500K,7500K,8200K,9300K,11500K
— sRGB Red
— User Define E Gresn
Blue

= English, Espafiol, Frangais, Deutsch, Italiang

Portugués, Pyccrkumid, kg
— Hoarizontal

— Wertical

— Transparency — Qff, 1, 2, 3, 4

— OS50 Time out — 5, 10, 20, 30, 60
— Power LED =0,1,2 34

— H.Pesition — 0~ 100
— . Position — 0~ 100
— Phase = 0=~ 100
— Clock — 0~ 100
— Resolution Motification — On, Off
— Resel — Yes, No

— Information
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Customer Care & Warranty

PLEASE SELECT YOUR COUNTRY/AREA TO REVIEW DETAILS OF YOUR
WARRANTY COVERAGE

WESTERN EUROPE: . Austria « Belgium . Denmark « France . Germany

. Greece . Finland . Ireland . Italy « Luxembourg . the Netherlands . Norway

. Portugal « Sweden . Switzerland « Spain « United Kingdom . Poland

EASTERN EUROPE: « Czech Republic - Hungary » Russia « Slovakia « Slovenia
» Turkey

LATIN AMERICA: « Argentina « Brasil

NORTH AMERICA: « Canada « USA

PACIFIC: « Australia » New Zealand

ASIA: « China « Hong Kong « India « Indonesia « Korea » Malaysia » Pakistan
« Philippines « Singapore « Taiwan « Thailand « Vietham

AFRICA: +« South Africa

MIDDLE EAST: « United Arab Emirates
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Consumer Information Centers

. Argentina « Australia » Brasil . Canada - New Zealand . Belarus . Bulgaria
« Croatia » Czech Republic « Estonia - United Arab Emirates « Hong Kong

» Hungary « India . Indonesia - Israel » Latvia » Lithuania . Malaysia

- Middle East + North Africa » New Zealand Pakistan » Romania . Russia

« Serbia & Montenegro - Singapore « Slovakia « Slovenia « South Africa

» South Korea . Taiwan « Philippines « Thailand « Turkey « Ukraine . Vietham

Eastern Europe

BELARUS

Technic al Center of JV IBA
M. Bogdanovich str. 155
BY - 220040 Minsk

Tel: +375 17 217 33 86

BELARUS

Service.BY

Petrus Brovky st. 19 — 101-B
220072, Minsk

Belarus

BULGARIA

LAN Service

140, Mimi Balkanska Str.
Office center Translog
1540 Sofia, Bulgaria

Tel: +359 2 960 2360
www.lan-service.bg



CZECH REPUBLIC

General Consumer Information Center
800 142100

Xpectrum

Lu.na 591/4

CZ - 160 00 Praha 6 Tel: 800 100 697 or 220 121 435
Email:info@xpectrum.cz

www.xpectrum.cz

CROATIA

Renoprom d.o.o.
Ljubljanska 4,

Sv. Nedjelja, 10431
Croatia

Tel: +385 1 333 0974

ESTONIA

FUJITSU SERVICES OU
Akadeemia tee 21G
EE-12618 Tallinn

Tel: +372 6519900
www.ee.invia.fujitsu.com

HUNGARY

Serware Szerviz
Vizimolnar u. 2-4

HU - 1031 Budapest

Tel: +36 1 2426331
Email: inbox@serware.hu
www.serware.hu

HUNGARY

Profi Service Center Ltd.



123 Kulso-Vaci Street,
H-1044 Budapest ( Europe Center )
Hungary

Tel: +36 1 814 8080
m.andras@psc.hu

LATVIA

ServiceNet LV

Jelgavas iela 36

LV - 1055 Riga,

Tel: +371 7460399

Email: serviss@servicenet.lv

LITHUANIA

ServiceNet LT

Gaiziunu G. 3

LT - 3009 KAUNAS

Tel: +370 7400088

Email: servisas@servicenet.It
www.servicenet.|t

ROMANIA

Blue Ridge Int'l Computers SRL
115, Mihai Eminescu St., Sector 2
RO - 020074 Bucharest

Tel: +40 21 2101969

SERBIA & MONTENEGRO

Kim Tec d.o.o.

Viline vode bb, Slobodna zona
Beograd L12/3

11000 Belgrade

Serbia

Tel. +381 11 20 70 684

SLOVAKIA



General Consumer Information Center
0800004551

Datalan Servisne Stredisko
Puchovska 8

SK - 831 06 Bratislava

Tel: +421 2 49207155
Email: servis@datalan.sk

SLOVENIA

PC HAND

Brezovce 10

S| - 1236 Trzin

Tel: +386 1 530 08 24

Email: servis@pchand.si

RUSSIA

CPS

18, Shelepihinskaya nab.
123290 Moscow

Russia

Tel. +7(495)797 3434

Profservice:

14A -3, 2Karacharovskaya str,
109202, Moscow ,

Russia

Tel. +7(095)170-5401

TURKEY

Tark Philips Ticaret A.S.

Yukari Dudullu Org.San.Bolgesi
2.Cadde No:22
34776-Umraniye/lstanbul

Tel: (0800)-261 33 02



UKRAINE

Comel

Shevchenko street 32

UA - 49030 Dnepropetrovsk
Tel: +380 562320045
www.csp-comel.com

LLC Topaz Company
Topaz-Service Company,
Mishina str. 3,

Kiev

Ukraine-03151

Tel: +38 044 245 73 31

ARGENTINA

Azopardo 1480.

(C1107ADZ) Cdad. de Buenos Aires
Tel: 0800 3330 856

Email: CIC.monitores@Philips.com

BRASIL

Alameda Raja Gabaglia, 188 - 10°Andar - V.
Olimpia - S. Paulo/SP - CEP 04551-090 -
Brasil

Tel: 0800-7254101

Email: CIC.monitores@Philips.com

AUSTRALIA

Company: AGOS NETWORK PTY LTD



Address: 4/5 Dursley Road, Yenorra, NSW 2161, Australia
Tel: 1300 360 386

Fax: +61-2-80808147

Email: philips@agos.com.au

Service hours: Mon.~Fri. 8:00am-7:30pm

NEW ZEALAND

Company: Visual Group Ltd.

Address: 28 Walls Rd Penrose Auckland
Phone: 0800 657447

Fax: 09 5809607

E-mail: vai.ravindran@visualgroup.co.nz
Service Hours: Mon.~Fri. 8:30am~5:30pm

HONG KONG/Macau

Company Name: PHK Service Limited

Address: Flat A, 10/F., Pak Sun Building, 103 - 107 Wo Yi Hop Road, Kwai Chung, New Territories, Hong
Kong

Tel.: (852) 2610-6908 / (852) 2610-6929 for Hong Kong and (853) 2856-2277 for Macau

Fax: (852) 2485 3574 for Hong Kong and (853) 2856 1498 for Macau

E-mail: enquiry@phkservice.com.hk

Service Hours: Mon.~Sat. 09:00am~06:00pm

India

Company: REDINGTON INDIA LTD

Address: SPL Guindy House, 95 Mount Road, Chennai 600032, India
Tel: +9144-42243352/353

E-mail: aftersales@in.aocmonitor.com

Service hours: Mon.~Fri. 9:00AM~5:30PM; Sat. 9:00AM~1:00PM

Indonesia

Company Name: PT. Gadingsari elektronika Prima

Address: Kompleks Pinang 8, JI. Ciputat raya No. 8F, Pondok Pinang. Jakarta
Tel: 021-750909053, 021-750909056

Fax: 021-7510982



E-mail: gepta@cbn.net.id
Service hours: Mon.~Fri. 8:30am~4:30pm; Sat. 8:30am~2:00pm

Additional service points:
1. Philips Building JI. Buncit Raya Kav 99. Jakarta Selatan.
Phone: 021-7940040, ext 1722/1724, 98249295, 70980942

2. JI. Tanah Abang 1 no 12S. Jakarta Pusat.
Phone: 021-3455150, 34835453

3. Rukan City Home no H31, Gading Square. JI. Bulevar Barat. Kelapa Gading. Jakarta Utara. Phone: 021-
45870601, 98131424

South Korea

Company: PCS One Korea Ltd.

Address: 112-2, Banpo-dong, Seocho-ku, Seoul, 137-040, Korea
Call Center Tel: 080-600-6600

Tel: 82 2 591 1528

Fax: 82 2 595 9688

E-mail: cic_korea@philips.com

Service hours: Mon.~Fri. 9:00AM~ 6:00PM; Sat. 9:00AM~1:00PM

Malaysia

Company: After Market Solutions (CE) Sdn Bhd

Address: Lot 6. Jalan 225/51A, 46100 Petaling Jaya, Selangor DE, Malaysia.
Phone: 603 7953 3370

Philips Info Line: 1-800-880-180

Fax: 603 7953 3338

E-mail: pceinfo.my@philips.com

Service Hours: Mon.~Fri. 8:15am~5:15pm; Sat. 9:00am~1:00pm

Pakistan

Philips Consumer Service
Address: Mubarak manzil, 39, Garden Road, Saddar, Karachi-74400
Tel: (9221) 2737411-16



Fax: (9221) 2721167
E-mail: care@philips.com
Website: www.philips.com.p

Singapore

Company: Philips Electronics Singapore Pte Ltd (Philips Consumer Care Center)
Address: 620A Lorong 1 Toa Payoh, TP4 Building Level 1, Singapore 319762
Tel: (65) 6882 3999

Fax: (65) 62508037

E-mail: consumer.care.sg@philips.com

Service hours: Mon.~Fri. 9:00am~6:00pm; Sat. 9:00am~1:00pm

Taiwan

Company: FETEC.CO

Address: 3F, No.6, Lane 205, Sec. 1, Chang Hsing Rd, Lu Chu Hs, Taoyuan, Taiwan R.O.C 33800
Consumer Care: 0800-231-099

Tel: (03)2120336

Fax: (03)3129184

E-mail: knlin08@xulite.net

Service hours: Mon.~Fri. 8:30am~7:00pm

Thailand

Company: Axis Computer System Co., Ltd.

Address: 1421 Soi Lardprao 94, Srivara Town In Town Soi 3 Road, Wangthonglang, Bangkok 10310
Thailand

Tel: (662) 934-5498

Fax: (662) 934-5499

E-mail: axiss@axiscomputer.co.th

Service Hours: Mon.~Fri. 08:30am~05:30pm

Vietnam

Company: Digiworld Corp

Address: 211-213 Vo Van Tan St, Ward 5, Dist.3 , Ho Chi Minh city, Vietnam
Tel: 848-38266065

Fax: 848-38267307



E-mail: Digicare@dgw.com.vn
Service hours: 8:00 to 12:00 AM and 13:30 to 17:30 PM (from Monday to Friday)

Philippines

Glee Electronics Inc
Contact nos. (632) 636-3636 / 7064028 to 29
Fax no. (632) 7064026

Receiving Centers

NEO CARE - Megamall
4th Level Cyberzone, Building B,
SM Megamall, Mandaluyong City

NEO CARE - SM North EDSA

4th Level Cyberzone, Annex Bldg.
SM City North EDSA, Quezon City
441-1610

MDR Microware Sales Inc.

Cebu Branch

N. Escario corner Clavano St., Cebu City Phils.
# 255-4415/ 255-3242/253-9361/4124864 to 67
Sun # 0922-8210045 to 46

Davao Office:

C. Arellano St., Davao City 8000
082- 225-3021/225-3022

Sun# 0922-8210015

CDO Office:

1445 Corrales Ext.,CDO City
088-856-8540/856-8541

Sun # 0922-8210080

lloilo Office:

C. Lim Comp., Gomez St., lloilo City
# 033 338-4159/ 033 508-3741

Sun # 0922-8808850



SOUTH AFRICA

Company name: Sylvara Technologies Pty Ltd

Address: Ho Address Palm Springs Centre Christoffel Road Van Riebeeck Park Kempton Park, South Africa
Tel: +27878084456

Fax: +2711 391 1060

E-mail: customercare@philipssupport.co.za

Service hours: Mon.~ Fri. 08:00am~05:00pm

Middle East
Middle East + North Africa

Company: AL SHAHD COMPUTER L.L.C

Address: P.O.BOX: 29024, DUBAI, UNITED ARAB EMIRATES
TEL: 00971 4 2276525

FAX: 00971 4 2276242

E-mail: shahd52@eim.ae

Service hours: Sat.~Thur. 9:00am~1:00pm & 4:00pm- 8:00pm

Israel

Company: Eastronics LTD

Address: 13 Rozanis St. P.O.B. 39300, Tel Aviv 61392 Israel

Tel: 1-800-567000 call free in Israel; (972-50-8353722 after service hours until 20:00)
Fax: 972-3-6458759

E-mail: eastronics@eastronics.co.il

Service hours: Sun.~Thurs. 08:00 - 18:00
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